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Legal information

Warning notice system
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

 DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

 

 
WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 
CAUTION

with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.
 

 
CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

 

 
NOTICE
indicates that an unintended result or situation can occur if the corresponding information is not taken into account.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation for the specific task, in particular its warning notices and safety 
instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying 
risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

 
WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be adhered to. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

 Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY
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Overview 1
1.1 What's new in WinCC flexible 2008?

Optimizing performance in Runtime   
● Enhancement of the performance of alarm logs and tag logs

New functionality and functional enhancements

CSV import/export

● New menu command for CSV import / export

● CSV import / export for tags and alarms

Extended user administration

● Number of failed login attempts can be set

● Logon is only possible with password

● Graduated authorizations for administration

● Exclusion of groups from password aging

● Hidden password input

Editors

● Screens, text lists

– Output fields in texts

● Events at objects

– Operator input completed

– Leaving a pressed button

● Faceplates

– Size of faceplate instances

– Project texts of faceplates can be exported

● Alarms

– Display of the absolute address for discrete alarms

● Device settings

– Disable function keys on modal dialogs

What's new in WinCC flexible 2008
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ES and RT system functions

● New system function

– SetDaylightSaving

– EncodeEx

● Enhancement of existing system functions

– ChangeConnection

– ArchiveLogFile

– NotifyUserAction

Transfer:

● S7 routing via Ethernet

● Transfer of the operating system image via Ethernet

● Adjustable transmission rate of the Ethernet interface

Runtime options

● Sm@rtService/Sm@rtAccess

● ProSave

– Upload / download of recipe data records as CSV file.

HMI devices

Support for new HMI devices

● New Panel

– TP  177B 4"

● New Multi Panel

– MP 177 6" Touch

● Basic Panels

– New Panel series

● New panel PCs

Licenses
● New RT license: "WinCC flexible 2008 Runtime (4096)"

● Raised system limit to support 4096 tags on MP 377

Overview
1.1 What's new in WinCC flexible 2008?
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See also
Optimizing performance in Runtime (Page 13)

CSV import/export (Page 14)

Extended user administration (Page 16)

Screens, text lists (Page 19)

Events at objects (Page 20)

Faceplates (Page 22)

Alarms (Page 22)

Device settings (Page 23)

Transfer (Page 25)

ES and RT system functions (Page 24)

ProSave (Page 26)

Sm@rtService/Sm@rtAccess (Page 39)

New Panel (Page 27)

New Multi Panel (Page 28)

New Panel series (Page 28)

New panel PCs (Page 29)

Operating systems (Page 50)

Licenses (Page 29)

1.2 What's new in WinCC flexible 2008 SP1?

Introduction
The Service Pack 1 for WinCC flexible 2008 is a free upgrade from WinCC flexible 2008.   

In addition to numerous optimizations in the current software version, Service Pack 1 offers a 
range of functional enhancements.

Improved usability
● Larger tag selection field

● Object list saves size

● Quick info can be switched off

Overview
1.2 What's new in WinCC flexible 2008 SP1?
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New functionality and functional enhancements

CSV import/export

● CSV import/export of text lists

Editors

● Logs

– Logging language for logs and Audit Trail

– Logging of Asian texts

– Logs with checksums

– Logging alarm texts in Audit Trail

● Screens

– "Go to definition" shortcut menu

● Recipes

– Exporting and importing recipe data with a checksum

● Tags

– Language-dependent display names

● Reports

– Printout of Audit Trail

● System alarms

– "Incoming" event

Transfer:

● Indirect transfer with "Pack & Go"

● Updating modified characteristics for the operating system

Overview
1.2 What's new in WinCC flexible 2008 SP1?

What's new in WinCC flexible 2008
8 System Manual, 03/2010, Printout of the Online Help



Runtime options

● Sm@rtService/Sm@rtAccess:

– Hidden input of the password via Sm@rtClient

– Sending secure e-mails

HMI devices
● Printing via print server

See also
Improved usability (Page 31)

Tags (Page 36)

Recipes (Page 35)

Logs (Page 32)

System alarms (Page 37)

Logs (Page 36)

Screens, text lists (Page 19)

Transfer (Page 25)

Sm@rtService/Sm@rtAccess (Page 39)

Printing via print server (Page 41)

New Panel series (Page 28)

Operating systems (Page 50)

1.3 What's new in WinCC flexible 2008 SP2?

Introduction
Service Pack 2 for WinCC flexible 2008 is a free upgrade from WinCC flexible 2008 and 
WinCC flexible 2008 SP2.   

Engineering and usability
● New menu command for clearing the list of most recently opened projects

● Object view shows additional information

– Tag comments

– Recipe number

● New wide screen resolutions for WinCC flexible Runtime

Overview
1.3 What's new in WinCC flexible 2008 SP2?
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New functionality and functional enhancements

Communication

● Modicon Modbus TCP/IP

● Mitsubishi FX

● Omron Hostlink/Multilink

Runtime options

● Sm@rtService/Sm@rtAccess:

– Enhanced performance

– Automatic scaling for different screen resolutions

– Clearer configuration dialogs for Sm@rtServer and Sm@rtClient

HMI devices
● Mobile Panel:

– Mobile Panel 277F IWLAN (RFID Tag)

– Mobile Panel 277 (F) IWLAN V2

● Basic Panel

– Retentive message buffer

– Support of additional system functions

– Expanded quantity framework

● Accessories

– Memory card

– UPS Module

Overview
1.3 What's new in WinCC flexible 2008 SP2?
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Operating system
● Support for Microsoft Windows 7

See also
Improved usability (Page 31)

Communication (Page 45)

Performance (Page 46)

Automatic scaling (Page 46)

Revised configuration dialogs (Page 47)

Mobile Panel (Page 49)

New Panel series (Page 28)

Accessories (Page 50)

Operating systems (Page 50)

Overview
1.3 What's new in WinCC flexible 2008 SP2?
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WinCC flexible 2008 2
2.1 Optimizing performance in Runtime

Enhancement of the performance of alarm logs and tag logs

CSV file

Accelerated data storage on the basis of current CSV logging.

New logging format: RDB     

Data can now be saved in RDB format. RDB is an internal format of Runtime. The optimized 
data storage accelerates read and write access. Logs of this format can only be read or 
displayed using WinCC flexible Runtime.

The selection of the storage location was expanded at the "Alarm log" and "Data log" for the 
RDB format.

Figure 2-1 "Alarm log" editor

Convert the RDB file to CSV format using the "CopyLog" function to make the data available 
for applications outside of WinCC flexible Runtime. 

Supported HMI devices:

xP 277, Mobile Panel 277, Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN, MP 377, 
WinCC flexible Runtime

What's new in WinCC flexible 2008
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2.2 New functionality and functional enhancements

2.2.1 CSV import/export

Enhancements for CSV import / export  
● Enhancements in WinCC flexible ES  

– A new command for the import and export of CSV files was added to the "Project" menu.

Figure 2-2 "Import/export" menu item

● New importable/exportable objects

– Alarms

– Tags

– Connections

– Text lists (WinCC flexible 2008 SP1)

WinCC flexible 2008
2.2 New functionality and functional enhancements
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Figure 2-3 CSV export of text lists

WinCC flexible 2008
2.2 New functionality and functional enhancements
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2.2.2 Extended user administration

"Runtime security settings" editor

The "Runtime security settings" editor has been expanded to include the following:

WinCC flexible 2008
2.2 New functionality and functional enhancements

What's new in WinCC flexible 2008
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● Advanced password rules in the "Password" area
"Number of failed login attempts"
You can now define the number of invalid login attempts. Users exceeding the number of 
invalid login attempts in Runtime are assigned to the "Unauthorized" group.
The number of login attempts is unlimited if you enter the value zero for the number of 
invalid login attempts.

● Advanced password rules in the "Password security" area
"Login using password exclusively"
Users are only authenticated in Runtime by means of the password. 
For proper user identification, do not assign any redundant passwords. 

● New "Group administration" area
"Group number hierarchy"
Administrators administer only those users whose group number is less than or equal to 
that of the administrator. The group numbers can be edited. Allows the creation of 
administrators with different permissions.

"Groups" editor
You can exclude specific groups from password aging in the "Groups" editor.

Hidden password input
● In WinCC flexible 2008, password input is hidden in the user view.

● A password change must be confirmed by entering the new password twice. This repeated 
entry meets requirements issued by the FDA.

WinCC flexible 2008
2.2 New functionality and functional enhancements
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Supported HMI devices:

OP 77B, xP 177, xP 277, MP 370, MP 377

WinCC flexible 2008
2.2 New functionality and functional enhancements
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2.2.3 Editors

2.2.3.1 Screens, text lists

 Output fields in texts 
You can insert output fields in texts for the following objects. Output fields can be tag values 
and text list entries.

● "Screens" Editor

– Text Field

– Symbolic I/O field

– Button

– Switch

● "Text list" editor

– Text list entry
You can also output control tag values in text lists.

WinCC flexible 2008
2.2 New functionality and functional enhancements
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Figure 2-4 Example of the "Screens" editor: Output field in the text of a button

Figure 2-5 Example of the "Text list" editor: Output field in a text list entry 

2.2.3.2 Events at objects

On Finish Input
The "On Finish Input" event is triggered after you have confirmed your entries at an I/O field 
by pressing ENTER, by mouse click or by touch screen operation.

Configurable objects:

WinCC flexible 2008
2.2 New functionality and functional enhancements
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I/O fields, graphic I/O field, symbolic I/O field

Release
You can define whether to trigger the "Release" event after the operator has released a specific 
button. Activate this setting in the "Device settings" editor. 

Figure 2-6 "Device settings" editor

WinCC flexible 2008
2.2 New functionality and functional enhancements
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2.2.3.3 Faceplates

Faceplates

Figure 2-7 "Faceplate configuration" dialog

● Aspect ratio
Define the aspect ratio for the faceplate instance when you create a faceplate. Select "Keep 
ratio" to maintain the aspect ratio when resizing the faceplate instance. You cannot resize 
the faceplate instance after having selected "Fixed size".

● Importing and exporting texts
You can export any texts you may be using in faceplates to a CSV file and you can import 
these texts. Use the export file to transfer the faceplate text to external service providers, 
e.g. for translation purposes. 

2.2.3.4 Alarms

Enhanced view in the "Discrete alarms" editor
The "Trigger address" column was added to the "Discrete alarms" editor. This column displays 
the address of the trigger tag. Use this address for correct addressing of the trigger tag in the 
PLC. 

Figure 2-8 "Discrete alarms" editor

WinCC flexible 2008
2.2 New functionality and functional enhancements

What's new in WinCC flexible 2008
22 System Manual, 03/2010, Printout of the Online Help



2.2.3.5 Device settings

Disable function keys on modal dialogs
You could unintentionally trigger an operation as the function keys remain active on a modal 
dialog. The "Disable function keys on modal dialogs" function in the "Device settings" editor 
disables the function keys for the duration of the displayed dialog.

Figure 2-9 "Device settings" editor

WinCC flexible 2008
2.2 New functionality and functional enhancements
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To evaluate the status of a PLC, you can configure the following events in the Scheduler after 
a modal dialog has opened:

● When dialog is opened

● When dialog is closed

2.2.3.6 ES and RT system functions

New system functions

SetDaylightSaving

The system function "SetDaylightSaving" changes the time of the HMI device from standard 
to daylight saving time and vice versa.

Available on:

TP/OP/MP 277, MP 370, Mobile Panel 277, Mobile Panel 277 IWLAN, 
Mobile Panel 277F IWLAN, MP 377

EncodeEx

The system function is an enhancement of the "Encode" system function. Contrary to the 
"Encode" system function, you can define the line break parameter. Use the "Line break" 
parameter to delete line breaks or replace them with predefined characters.

Available on: 

OP 77B, TP/OP 177B, Mobile Panel 177, TP/OP/MP 277, Mobile Panel 277, 
Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN, MP 370, MP 377

Enhancement of existing system functions

ChangeConnection

The following connections via Ethernet port are supported:

● SIMATIC S7 300/400

● SIMATIC S7 200

● Simotion

● SimaticNC

ArchiveLogFile

The "Directory name" parameter can be specified by means of a tag.

NotifyUserAction

The following parameters can be specified by means of a tag:

● Category

● Object name

● Description

WinCC flexible 2008
2.2 New functionality and functional enhancements
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2.2.4 Transfer

S7 routing via Ethernet 
WinCC flexible 2008 also supports S7 routing via Ethernet. 

Possible S7 routing paths:

Source Target

Ethernet Ethernet
Ethernet MPI/PROFIBUS
MPI/PROFIBUS Ethernet

Supported HMI devices:

TP 177B 4", Mobile Panel 277, MP 177, MP 277, MP 377, WinCC flexible Runtime

Bootstrapping via Ethernet 
The following HMI devices now support the transfer of the operating system image (bootstrap) 
via Ethernet.

TP 177B 4", MP 377, TP1500 Basic PN, KTP1000 Basic PN, KTP600 Basic color PN, KTP600 
Basic mono PN and KTP400 Basic mono PN

Transmission rate of the Ethernet interface 
The "Ethernet Parameters" tab was added to the "Ethernet Settings" dialog in the Control Panel 
of HMI devices MP 177, MP 277 and MP 377.

You can set the following in the "Ethernet Parameters" tab:

● 100 Mbps / full duplex

● 100 Mbps / half duplex

● 10 Mbps / full duplex

WinCC flexible 2008
2.2 New functionality and functional enhancements
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● 10 Mbps / half duplex

● Automatic

2.2.5 Runtime options

2.2.5.1 ProSave

Enhanced data backup
ProSave now provides an option for backing up or exporting recipe data records to a CSV file. 

WinCC flexible 2008
2.2 New functionality and functional enhancements
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You can transfer this backup of recipe data to the target device to restore its original state.

Supported HMI devices:

OP77A, TP177A, KTP400 Basic, KTP600 Basic, KTP1000 Basic, TP1500 Basic

2.2.5.2 Sm@rtService/Sm@rtAccess

Service and diagnostics
WinCC flexible/Sm@rtAccess and WinCC flexible/Sm@rtService have changed as follows:

● The options can be used on the new Ethernet-enabled HMI devices:

– MP 177 6" Touch

– TP  177B 4"

2.3 HMI devices

2.3.1 Support for new HMI devices

2.3.1.1 New Panel

TP 177B 4"  
The TP 177B 4" features a 4.3" TFT display with wide-screen format. This display extends the 
visible area on the HMI device by approximately 25 % compared to similar displays with 4:3 
format. The HMI device also features four function keys with tactile feedback. In combination 
with the intuitive touch operation, it offers maximum operating efficiency. In addition to MMC 
cards, the TP 177B 4" supports SD cards and USB memory sticks. 

The TP 177B 4" features:

● TFT screen with up to 256 colors

● 480 x 272 pixels resolution

● Backlit LED, dimmable from 20% to 100%

● PROFIBUS interface

● Ethernet port for connection to PROFINET (LAN)

● USB interface 

● PROFIBUS DP or PROFINET IO direct keys by means of touch and function keys

The following software options are available for the TP 177B 4": 

WinCC flexible 2008
2.3 HMI devices
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● WinCC flexible/Sm@rtService

● WinCC flexible /Sm@rtAccess

2.3.1.2 New Multi Panel

MP 177 6" Touch
Multi Panel MP 177 with 6" touch display represents an enhancement of the Multi Panel device 
family.

All Multi Panels are based on the innovative standard operating system Microsoft Windows 
CE 5.0. Multi Panels offer enhanced communication options to the office world. All Multi Panels 
feature a special hardware which provides optimal support for WinAC MP (software PLC). 

The MP 177 offers great diversity for applications, high performance and a favorable cost/
performance ratio.

The MP 177 features:

● PROFIBUS interface

● Ethernet interface for connection to PROFINET (LAN)

● USB interface

● TFT screen with up to 64k colors

The functionality of MP 177 as a "multifunctional platform" was enhanced with the following 
software options:

● WinAC MP (software PLC)

● Sm@rtService

● Sm@rtAccess

2.3.1.3 New Panel series

SIMATIC HMI Basic Line 
The SIMATIC HMI Basic Line offers touch panels for simple operating and monitoring tasks.

Installation of the SIMATIC HMI Basic Line is compatible with existing touch HMI devices of 
the Panel and Multi Panel product family. The HMI devices are available with four different 
display sizes from 4 to 15 inches. All HMI devices are equipped with an Ethernet interface. 

WinCC flexible 2008:

● TP1500 Basic PN

● KTP1000 Basic PN, KTP1000 Basic DP

WinCC flexible 2008 SP1:

● KTP600 Basic color PN, KTP600 Basic color DP, KTP600 Basic mono PN

● KTP400 Basic mono PN

WinCC flexible 2008
2.3 HMI devices
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2.3.1.4 New panel PCs

New panel PCs
The following Panel PCs can be configured using WinCC flexible 2008:

● Panel PC 477 19’’ Touch

● Panel PC 677 17’’ Touch

2.4 Licenses

New WinCC flexible Runtime license
A new license key is available to cover the extended system limits: "WinCC flexible 2008 
Runtime (4096)"

Extended system limit
The maximum number of tags within a project was raised to 4096 tags.

Supported HMI devices:

WinCC flexible Runtime, MP 377

WinCC flexible 2008
2.4 Licenses

What's new in WinCC flexible 2008
System Manual, 03/2010, Printout of the Online Help 29





WinCC flexible 2008 SP1 3
3.1 Improved usability

Larger tag selection field

The size of the tag selection field has been extended. This means long tag names can now 
be read more easily.

Object list saves size

You can adapt the object list to suit your needs. This change will be saved even if you exit 
WinCC flexible. 

The next time you open the object list in WinCC flexible you will not have to adapt the object 
list.

Tooltip can be switched off

Switch off Tooltip and Tooltip extension in the "Help" menu.

What's new in WinCC flexible 2008
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3.2 New functionality and functional enhancements

3.2.1 Editors

3.2.1.1 Logs

Log language    
You can specify the log language for data logs, alarm logs, and Audit Trail.

In the "Device Settings" editor, select the language to be used for writing to logs in runtime.

Figure 3-1 "Device settings" editor - log language

The following options are available:

Startup language: The most recently activated runtime language is activated when Runtime 
restarts.

Runtime language: The logs are always written in the selected language. 

WinCC flexible 2008 SP1
3.2 New functionality and functional enhancements
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Supported HMI devices:

xP 277, MP 377, Mobile Panel 277, Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN, 
WinCC flexible Runtime

Logging of Asian texts    
The "TXT (Unicode)" file format supports all characters used in WinCC flexible and 
WinCC flexible Runtime, for example, Chinese characters.

For editing, you will need software that can save files in Unicode, such as Notepad. 

The selection of the storage location was expanded for the "Alarm log" and "Data log" as well 
as Audit Trail  for the "TXT (Unicode)" file format. 

Figure 3-2 Supported data log - TXT (Unicode) file

Supported HMI devices:

xP 277, MP 377, Mobile Panel 277, Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN, 
WinCC flexible Runtime

Logs with checksums    
In a regulated project or one subject to GMP, you have the option of assigning a checksum to 
the log data of a data log or alarm log. This checksum ensures that the entry has not been 
modified subsequently.

(GMP = Good Manufacturing Practice)

Figure 3-3 Example data log - activating the checksum

The checksum can only be calculated for the following:

WinCC flexible 2008 SP1
3.2 New functionality and functional enhancements
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● Storage location: CSV file or TXT(Unicode) file

● Logging method: "Display system event at" or "Trigger event"

Supported HMI devices:

xP 277, MP 377, Mobile Panel 277, Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN, 
WinCC flexible Runtime

Logging alarm texts in Audit Trail
You can now specify if the alarm text of acknowledged alarms is to be saved in Audit Trail. 

Figure 3-4 "Audit Trail" editor

Supported HMI devices:

xP 277, MP 377, Mobile Panel 277, Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN, 
WinCC flexible Runtime

3.2.1.2 Screens

Screen Editor

New "Go to definition" command in the shortcut menu

If the object property is linked to 
a                                                                                                                                                  
                                                                                                                                                    
                                                                                                                           tag, text list or 
graphic list in an object, the "Go to definition" command is made available in the shortcut menu, 
for example, IO field.

Example:

The IO field is linked with a tag. The "Tags" editor is opened with the "Go to definition" command 
and the corresponding tag is selected.

WinCC flexible 2008 SP1
3.2 New functionality and functional enhancements

What's new in WinCC flexible 2008
34 System Manual, 03/2010, Printout of the Online Help



Figure 3-5 IO field - "Go to definition" shortcut menu

3.2.1.3 Recipes

Exporting and importing recipe data with a checksum  
In regulated projects subject to GMP, you can assign recipe data with a checksum during an 
export. The checksums are checked during the import of recipe data. The import is aborted if 
a checksum is invalid.

(GMP = Good Manufacturing Practice)

Supported HMI devices:

xP 277, MP 377, Mobile Panel 277, Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN, 
WinCC flexible Runtime

WinCC flexible 2008 SP1
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3.2.1.4 Tags
The "Display name" column was added to the "Tags" editor. You can enter a language-
dependent name for the "Display name". The configured display name is shown instead of the 
tag name in the selected runtime language when tags are used in a trend display and in Audit 
Trail.  

Supported HMI devices:

TP 177B 4", MP 177 6", xP 277, MP 377, Mobile Panel 277, Mobile Panel 277 IWLAN, Mobile 
Panel 277F IWLAN, WinCC flexible Runtime

3.2.1.5 Logs

Printout of Audit Trails
The "Audit Trail" report object is available for the printout of Audit Trail. The report object is 
only available in regulated projects or those subject to GMP.

(GMP = Good Manufacturing Practice)

Figure 3-6 Report - Printing Audit Trail

Logging of Audit Trail must first be stopped before you print an Audit  in Runtime. 

Supported HMI devices:

xP 277, MP 377, Mobile Panel 277, Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN, 
WinCC flexible Runtime

WinCC flexible 2008 SP1
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3.2.1.6 System alarms

"Incoming" event
The "Incoming" event occurs when a system alarm is triggered and displayed in the alarm 
view. You can configure functions or scripts for the alarm. The configured functions or scripts 
are then executed when the system alarm occurs.

Figure 3-7 "System alarms" editor - "Incoming" event

Supported HMI devices:

OP 77B, xP 177, xP 277, MP 377, Mobile Panel 277, Mobile Panel 277 IWLAN, Mobile Panel 
277F IWLAN, WinCC flexible Runtime
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3.2.2 Transfer

Indirect transfer with "Pack & Go" 
The "Use Pack & Go" option was added to the "Transfer setting" dialog. 

Figure 3-8 Transfer - Pack & Go

If this option is selected, a ZIP file is created for the WinCC flexible project on the configuration 
PC. You can also specify if the WinCC flexible project should be divided into several ZIP files, 
for example, 2 MB files for sending per e-mail. The configuration PC is not connected to the 
HMI device while the "Pack & Go" file is being generated.

You can unzip the file on another PC, the transfer PC. The transfer PC does not require a 
WinCC flexible installation, but it is connected to the HMI device.

Supported HMI devices:

OP 73micro, TP 177micro, OP 73, OP 77A, OP 77B, MP 177, TP 177A, TP/OP 177B, xP 277, 
MP 377, Mobile Panel 177, Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN, TP1500 
Basic PN, KTP1000 Basic PN, KTP600 Basic color PN, KTP600 Basic mono PN, KTP400 
Basic mono PN

Updating modified characteristics for the operating system
The transfer has so far been aborted if the image of the operating system of a Windows CE 
panel was not compatible with the configuration. The operating system had to be updated 
manually.

With WinCC flexible 2008 SP1, a message appears asking if you wish to update the operating 
system. If you click "Yes", the operating system is updated automatically.

WinCC flexible 2008 SP1
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3.2.3 Runtime options

3.2.3.1 Sm@rtService/Sm@rtAccess

Hidden password entry via Sm@rtClient

Password input at the Sm@rtServer

If you enter the password directly on the Sm@rtServer, the following message is displayed on 
the Sm@rtClient instead of the on-screen keyboard of the server: "Remote access by Sm@rt 
Options is in progress. Please wait until password has been entered." This setup prevents that 
keyboard input is displayed on the Sm@rtClient when you enter the password.

Password input at the Sm@rtClient

The on-screen keyboard is hidden on the Sm@rtServer due to the actions carried out on the 
Sm@rtClient. The local on-screen keyboard is shown for entries on the Sm@rtClient instead.

Supported HMI devices

xP 177, xP 270, xP 277, MP 370, MP 377, Mobile Panel 177, Mobile Panel 277, Mobile Panel 
277 IWLAN, Mobile Panel 277F IWLAN, WinCC flexible Runtime

Secure sending of emails
To ensure secure transmission of e-mails, you can now use SMTP servers that support SMTP 
AUTH (authentication).

The following authentication modes can be configured:

● Authentication by means of a valid e-mail address

● Authentication by means of user name and password

Data can also be encrypted and sent via an SSL connection. The means the data cannot be 
manipulated or read. 

You can make the settings in the "Device Settings" editor or in the Control Panel of the HMI 
device.

WinCC flexible 2008 SP1
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Figure 3-9 "Device settings" editor - SMTP settings

Supported HMI devices

xP 177 , xP 277, MP 377, Mobile Panel 177, Mobile Panel 277, Mobile Panel 277 IWLAN, 
Mobile Panel 277F IWLAN, WinCC flexible Runtime

WinCC flexible 2008 SP1
3.2 New functionality and functional enhancements

What's new in WinCC flexible 2008
40 System Manual, 03/2010, Printout of the Online Help



3.3 HMI devices

3.3.1 Printing via print server

Introduction
Print servers enable access to network printers.  Print jobs are routed to a corresponding printer 
via the print server. 

Requirements
● The print server deploys the "RAW" mode.

 

  Note

For additional information on settings, refer to the relevant print server documentation.
 

● The Panel is interconnected via Ethernet with the print server or with a printer featuring an 
integrated print server.

● External print servers are interconnected with a printer via USB port.

● The IP address and port used are identical in the "Printer Properties" of the HMI device and 
on the print server.

Procedure
1. Open the "Control Panel" on your HMI device.

2. Select "Printer". The "Printer Properties" dialog box opens.

3. Select a printer from the "Printer Language" selection list.

4. Select the "PrintServer" entry from the "Port" selection list.

WinCC flexible 2008 SP1
3.3 HMI devices
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5. Enter the IP address and the port used for communication with the printer in the "IP:Port" 
input field.

 

  Note

Use the ":" character as delimiter between the IP address and the port number. For 
example: "192.168.56.23:9100".

 

6. Select any additional printer settings.

Result
After the print job was initiated, the HMI device transfers the print job to the printer via the print 
server.

 

 Note

Printing takes place via the print server for the following HMI devices:
● xP 177, Mobile Panel 177
● xP 277, Mobile Panel 277, Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN
● Mobile Panel 277 IWLAN V2, Mobile Panel 277F IWLAN V2, Mobile Panel 277F IWLAN 

(RFID Tag)
● MP 377
● PC with WinCC flexible Runtime

 

WinCC flexible 2008 SP1
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WinCC flexible 2008 SP2 4
4.1 Engineering and usability

New menu entry in "Project" menu
WinCC flexible saves the most recently opened projects in a list. You can clear the list of most 
recently opened projects using the "Project" menu.

Menu > Last opened projects >Clear last opened projects 

What's new in WinCC flexible 2008
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Object view shows additional information
● Tag comments

The tag comments are listed in the object view.

● Recipe number
The object view shows the unique recipe number.

New wide screen resolution for WinCC flexible Runtime
Additional wide screen resolutions are now available for WinCC flexible Runtime:

● 1440 x 900

● 1680 x 1050

● 1920 x 1080

● 1920 x 1200

WinCC flexible 2008 SP2
4.1 Engineering and usability
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4.2 New functionality and functional enhancements

4.2.1 Communication

Modicon Modbus TCP/IP 
The following Basic Panels can communicate the with following controls via Modbus TCP/IP:

● HMI device

– KTP400 Basic PN

– KTP600 Basic PN

– KTP1000 Basic PN

– KTP1500 Basic PN

● Modicon PLC

– TSX Compact

– TSX Quantum

– Momentum

– Premium

– Micro

WinCC flexible 2008 SP2
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Mitsubishi FX
The following HMI devices can communicate with a Mitsubishi FX control via RS-4222:

● HMI device

– KTP600 Basic DP

– KTP1000 Basic DP

– OP 77A

– TP 177A

Omron Hostlink/Multilink
The following HMI devices can communicate with an Omron control via RS-4222:

● HMI device

– KTP600 Basic DP

– KTP1000 Basic DP

– OP 77A

– TP 177A

4.2.2 Sm@rtService/Sm@rtAccess

4.2.2.1 Performance

Introduction
Not only the functions but also the performance for WinCC flexible 2008 SP2 has been 
improved.

The performance was enhanced through the following improvements:

● Reduced CPU utilization due to Sm@rtServer

Reduced CPU utilization due to Sm@rtServer
If the CPU utilization is reduced, other applications will run faster. Enhanced performance of 
the Sm@rtServer improves the update of the Sm@rtClient. 

Supported HMI devices:

WinCC flexible Runtime, MP 377, MP 277, Mobile Panel 277, MP 177, TP 177 4"

4.2.2.2 Automatic scaling
So far the display of the transmitted server desktop has been scaled according to your entries 
on the Sm@rtClient. 

WinCC flexible 2008 SP2
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As of SP2 of WinCC flexible 2008, automatic scaling of the display on the Sm@rtServer is 
supported. 

Automatic scaling depends on the resolution and the aspect ratio. You can only reduce the 
display of the transmitted server desktop but not enlarge it.

● Same aspect ratios
The display of the server desktop will be adapted to the Sm@rtClient by the Sm@rtServer 
without distortion.

● Different aspect ratios
The display of the server desktop will be adapted to the Sm@rtClient by the Sm@rtServer 
with the aspect ratio. The "empty" areas on the Sm@rtClient will be filled with black. This 
may result in black bars above or below or to the right or left of the screen.

● Automatic scaling will transmit the image of the server desktop in an optimized, reduced 
resolution to the client.

Advantages
● Automatic adaptation to different clients

● Reduced CPU utilization on the clients

● Reduced network load

Supported HMI device: 

WinCC flexible Runtime as Sm@rtServer

4.2.2.3 Revised configuration dialogs
For WinCC flexible 2008 SP2, new functions have been added to existing functions of the 
Sm@rtServer and Sm@rtClient. 

The layout of the configuration dialogs has been revised to improve usability. 

WinCC flexible 2008 SP2
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● The settings are now grouped according to their functions in the respective tabs.

Figure 4-1 Dialog "Sm@rtServer: Current User Properties"

Figure 4-2 "Sm@rtClient Options" dialog

● You will receive information on the settings using direct help. To show the direct help, click 
on  in the title bar and then on the respective setting.
 

 

WinCC flexible 2008 SP2
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4.3 HMI devices

4.3.1 Mobile Panel

Mobile Panel 277F IWLAN (RFID Tag)
Use WinCC flexible 2008 SP2 to configure the new device version Mobile Panel 277F IWLAN 
(RFID Tag). Instead of an effective range module, the Mobile Panel 277F IWLAN (RFID Tag) 
comes equipped with an RFID module. The RFID module meets ISO 5693 quality standards. 

V2 of existing Mobile Panels
The Mobile Panel 277 IWLAN V2 and the Mobile Panel 277 IWLAN V2 are offered in the 
variants already known from Mobile Panel 277F IWLAN. 

It also provides the following new features:

● SIMOTION support

● Rapid Roaming iPCF-MC
Uninterruptable change in between access points.

● Transponder V2
Coexistence in the 2.4 and 5 GHz band

● additional wireless approval, for example in China

● Improved operation
 
 

4.3.2 Enhancements in the Basic Panels

Retentive message buffer
The content of the internal message buffer will remain intact even after restart of the HMI device.

If you are already working with Basic Panels, you can activate the retentive message buffer 
without changing the hardware. You only need to update the operating system image.

Support of additional system functions
The following system functions are supported by the Basic Panels with WinCC flexible 2008 
SP2:

● SetBitInTag

● ResetBitInTag

● InvertBitInTag

WinCC flexible 2008 SP2
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Expanded quantity framework
The number of tags in a project has been increased.

 Number of tags in the project
 Previously WinCC flexible 2008 SP2

KTP400 Basic 128 250
KTP600 Basic
KTP1000 Basic
TP1500 Basic

256 500

4.3.3 Accessories

SD Card  
For the following HMI devices, you can use SD Cards in addition to Multi Media Cards:

● OP77B

● Mobile Panel 177B mono 6" DP, Mobile Panel 177B Color 6" PN/DP

● OP 177B mono 6" DP, OP 177B color 6" PN/DP

● OP 277 6"

● TP 277 6"

Maintenance-free UPS
The following uninterruptible 24 VDC UPS power supply with highly capacitive double-layer 
capacitors will be supported:

● SITOP UPS500S

4.4 Operating systems

Support for new operating systems  
The following operating systems are supported: 

WinCC flexible 2008 SP2

 WinCC 
flexible 
2008 SP2

WinCC flexible 2008 SP2
Micro

WinCC flexible 2008 
SP2 Runtime

Windows XP Home SP 3 -- x --
Windows XP Professional SP3 x x x

WinCC flexible 2008 SP2
4.4 Operating systems
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 WinCC 
flexible 
2008 SP2

WinCC flexible 2008 SP2
Micro

WinCC flexible 2008 
SP2 Runtime

Windows 7 Professional x x x
Windows 7 Ultimate/Enterprise x x x

WinCC flexible 2008 SP2
4.4 Operating systems
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